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Introduction 

What SpaceMan 99 does 

SpaceMan 99 is a tool to help you organize your files.  Its two primary functions are to show 

how your disk space is being used, and to find duplicate files and folders.  Once you have 

found duplicate files, SpaceMan 99 can also automatically select files to delete whilst making 

sure that you always keep at least one copy of any files that have multiple copies. 

 

Quick tour 

SpaceMan 99 works in a similar way to the Windows Explorer application, except that it has 

two extra panels at the bottom that are used for showing duplicate files.  

The following screen shot shows SpaceMan 99 after a duplicates scan has been run. The 

various parts of the application window are indicated.  

 

 



   SpaceMan 99 User Guide 
 

5 

Toolbar This provides quick access to the most commonly used menu commands. 

Folder Browser This shows a hierarchical view of all the folders on the system. Each folder 

can be expanded or collapsed by clicking on the + or - symbol next to the 

folder name. When a folder and all its subfolders have been scanned for disk 

space, the disk space is shown to the left of the folder’s name in square 

brackets. The contents of the folder selected in the Folder browser are shown 

in the File Browser.  

Address Box This shows the currently selected folder. New paths can be entered in this 

box, or the last 20 quickly accessed from the drop-down list. 

File Browser This shows the folders and files in the currently selected folder. When a file 

has been scanned to test for duplicates, a symbol will appear to the left of its 

name, to show whether it is a duplicate or not. When all the files in a folder 

have been scanned to test for duplicates, a symbol will appear next to that 

folder’s name to show whether that folder is an exact duplicate of another 

folder.  

Status Bar This shows status information, such as the folder currently being scanned if a 

scan is in progress. 

Duplicates List When two (or more) duplicate files are found, a line is added to this list 

which shows the names of the duplicate files, and the size of the files.  

Find Duplicates 

Options 

These controls set whether duplicate files are scanned for, and if so, the 

criteria that must be met for two files to be considered to be duplicates. 

Duplicate Files This shows the individual files in the duplicates set selected in the Duplicates 

list. All the files shown in this list are duplicates of each other. 

 

Resizing the panels 

The sizes of each of these panels can be changed by moving the bars that run between them. 

There is a single bar running horizontally that separates the folder and file browsers from the 

duplicates list and the duplicate files browsers. This can be dragged up or down. There are 

two vertical bars that can be dragged independently. One separates the folder browser from 

the file browser, and the other separates the duplicates list browser from the duplicate files 

browser.  

 

System Requirements 

SpaceMan 99 runs on the following versions of Windows: 

 Windows Vista 

 Windows XP 

 Windows Server 2003 

 Windows 2000  
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Quick Start 

Launching SpaceMan 99 

From the Windows Start menu 

Like most programs, SpaceMan 99 can be run from the Windows Start menu.  From the 

Start menu, under Programs, you will find SpaceMan 99 under the start menu item you 

selected when you installed it. By default, this is SpaceMan 99, and under this you will find 

the menu item to launch SpaceMan 99 itself. 

From the Windows Explorer context menu 

An alternative way to launch SpaceMan 99 is from the Windows 

Explorer context menu.  This is useful if you have been using 

Windows Explorer to browse the file system, and you already have the 

folder you want to scan open in Windows Explorer. 

The simplest way to run Windows Explorer is to double click on the 

My Computer icon on your desktop.  When you right click on a folder 

in Windows Explorer, you will see a menu similar to the one shown 

here. 

You may not see exactly the same items, depending on the software 

you have installed on your computer.  However, if you select Open in 

SpaceMan 99, this will launch SpaceMan 99 with the folder already 

selected in SpaceMan 99. 

 Open in SpaceMan 99 only appears in this menu when you right 

click on a folder in Windows Explorer, if you right click on a file you 

will not see this option. 

 

Using online help 

At any time, you can press the F1 key to bring up the online help.  This help is context 

sensitive, so if a panel has popped up, the help shown will relate to that panel.  This is 

especially useful if you ever see an error message that you want to know more about.  Just 

press F1, and the on-line help will open with a full description of that error message. 

You can also press F1 while a menu item is selected to get help about that menu command. 

 

Selecting folders 

The currently selected folder is used by several commands to determine which folder to 

operate on.  One example is the File/Scan Folder command, which is described in the next 

section. 

The path of the currently selected folder is shown in the Address Box, and the contents are 

shown in the File Browser.   

Folders can be selected in a number of ways: 

 Click on the folder in the Folder Browser.  To expand a folder in the Folder Browser, 

either click on the + next to the folder, or simply double click on the folder name.  Folders 

can be collapsed by clicking on the - next to an expanded folder, or by double clicking on 

the folder name again. 
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 Enter the path to the folder in the Address Box, and press return. 

 Select the folder path from the drop down list attached to the Address Box.  The last 20 

folders selected can be quickly accessed by pressing the drop down list button to the right 

of the Address Box. 

 

Scanning folders 

To scan a folder, first select it as described in the previous section.  Then select the File/Scan 

Folder menu command. 

 If the Auto-scan when folders selected option is enabled (see “General Options panel” on 

page 31), you do not need to select the Scan Folder menu command, since folders will be 

scanned automatically when they are selected. 

More folders can be selected for scanning before the first has been finished. The path to the 

folder currently being scanned is shown in the status bar. When several folders have been 

selected for scanning, SpaceMan 99 gives priority to the currently selected folder. Once the 

currently selected folder (and all subfolders under it) has been scanned, SpaceMan 99 will 

scan all the remaining folders that have been selected for scanning.  

At any time, scanning can be aborted by selecting the File/Stop Scanning command.  

When all scanning is finished, SpaceMan 99 will flash briefly, and if the Beep when scan 

complete option is set, a beep will be sounded. 

 

Find disk space used 

To find the total disk space used by all the files in a folder, and in all subfolders under it, 

simply scan one or more folders as described in the previous section. 

The total disk space used by all files in a folder (and all subfolders) is shown in square 

brackets next to the folder name. If the square brackets next to a folder name are empty, it 

means the size for that folder is still being calculated.  

 If you only want to find folder sizes, make sure the Find Duplicate Files box is not 

checked.  This will make the scan much quicker. 

 

Finding and deleting duplicate files 

SpaceMan 99 has special purpose commands built in to help find and delete duplicate files.  

This is a three stage process.  Firstly, you scan folders to find duplicate files.  Next, you can 

mark particular duplicate files for deletion, using SpaceMan 99’s powerful commands which 

semi-automate this task.  Finally, the marked files can be deleted. 

Finding duplicate files 

To find duplicate files: 

 Make sure the Find Duplicate Files box is checked.  

 Set the options to configure how files are compared, as described in the section “Find-

Duplicates ” on page 15. 

 Scan the folders you want to search, as described in the section “Scanning folders” above. 

All duplicates found will be listed in the Duplicates List Browser.  
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Note that duplicate files can only be found if all the folders containing the copies of a file are 

scanned. For example, if there is a file in C:\Folder1 that has a duplicate in C:\Folder2, then 

if only C:\Folder1 is scanned, the file will be shown as unique. Only when C:\Folder2 is 

scanned as well will the duplication be found.  

Problems that can occur when scanning for duplicates 

You may find that sometimes when you select a folder for scanning, some files within it do 

not get scanned. This can be due to one of the following reasons:  

 The file is already open in another application. Close all other applications and try again.  

 You do not have read access for the file. Check the security settings of the file. 

Marking duplicate files 

Once SpaceMan 99 has finished scanning, you will have a list of all the duplicate files found 

in the Duplicates List Browser.  You can manually go through this list finding duplicate files 

to delete, however a much quicker way is to use the Mark Duplicate Files panel. 

This panel automatically marks duplicate files so that at least one copy is always kept.  It has 

four different options to determine which of the duplicate files to keep (i.e. to leave 

unmarked).  These options are described in section  

Bring this up by selecting the Mark/Mark Duplicate Files command. 

Deleting marked files 

Once you have marked one or more files, these can be deleted. 

If you want to see a list of the marked files before deleting them, select the MarkView Marked 

Files command.  This will bring up the Marked Files panel, which is described on page 28. 

To delete the marked files, select the Mark/Delete Marked Files. 

 When SpaceMan 99 deletes files, it uses the Windows Recycle bin settings to determine 

whether to display a confirmation dialog, and whether to move the files to the recycle bin or 

delete them immediately.  To view or change these settings, right click on the Windows 

Recycle bin, and select Properties from the menu that pops up. 

  

Find duplicate folders 

When SpaceMan 99 scans for duplicate files, it also looks for duplicate folders.  Two folders 

are considered to be duplicates of each other if they contain the same set of files, with the 

same filenames, and each pair of corresponding file meet the criteria set by the Find 

Duplicates Options. If the folders contain any subfolders, these must also be duplicates of 

each other. 

Duplicate folders are indicated in the File Browser in the same way as files by the  symbol. 

To find the other folders that are duplicates of a particular folder, select the folder in the File 

Browser and then select the Next Duplicate command from the File menu. 

Duplicate folders are also listed in the Duplicate Folders Report.  To bring up this report, 

select the Report command from the File menu, then select the Duplicate Folders tab. 

 

Viewing reports 

SpaceMan 99 can generate a number of reports that summarize the information found by the 

scan.  To view these reports, select the File/Report command. 
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Freeing disk space 
 

When your hard disk starts to get full, SpaceMan 99 allows you to see exactly where all the 

disk space is being used.  Simply scan the folders as described in the section “Find disk space 

used” on page 7.  

When looking for files to delete, it is best to start with the folders that are using the most disk 

space, since these provide the best opportunity for finding files to delete that will make the 

most difference. 

The other facility that SpaceMan 99 provides for finding files to delete is a duplicate files 

finder.  Usually, if you have multiple copies of the same file, then you can delete the extra 

copies.  Take care deleting files that you didn’t add yourself though - see the next section for 

more information about deleting duplicate files. 

Once you have used found duplicate files, SpaceMan 99 also provides powerful commands to 

help automate the process of deleting all copies except one.  These are described in the 

section “Finding and deleting duplicate files” on page 7. 

 

Deleting Files Safely 

You need to take great care when deleting files, since deleting the wrong file can cause an 

application, or even the whole system, to stop working. SpaceMan 99 has an option to protect 

the Windows operating system files, which it is recommended you leave enabled. This 

prevents any files in the Windows folder from being deleted. If you do need to delete a file in 

this folder, and you are sure that you know what you are doing, use the options panel to 

disable the protection.  

The best rule is: if you don’t know what a file is for, don’t delete it!  

The recycle bin can give you a second chance if you accidentally delete the wrong file. By 

default, SpaceMan 99 will send deleted files to the recycle bin, from where they can be 

retrieved. This does mean that the disk space used by deleted files is not recovered 

immediately, so you will need to periodically empty the recycle bin. For more information 

about the recycle bin, see the delete command on page 18. 

 

Removing applications 

One way to free disk space is to remove whole applications.   

However, an application should not be removed by simply deleting the folder into which it 

was installed. This is because an application often stores files in other folders as well as the 

one into which it was installed. Applications may also make entries into the system registry 

that should also be deleted when the application is removed.  

The correct way to remove an application is to un-install it. This is done from the 

Add/Remove Programs panel, as follows: 

 From the Windows Start menu, choose Settings, then Control Panel.  

 From the Control Panel, double click on Add/Remove Programs.  

 The Add/Remove Programs panel shows a list of all the applications installed on the 

system. Select the application you want to remove, then click the Add/Remove button.  
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If the application is not listed in the Add/Remove Programs panel, then it may be that it has a 

standalone un-install program. Look in the Windows Start menu to see if the application has 

an entry that contains an un-install program.  

If you can not find an un-install program for the application, then you have no choice but to 

remove it manually, by deleting the folder into which the application was installed. However, 

only remove it this way as a last resort 
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Main Window 

Folder Browser 

 

 

The Folder Browser is used to:  

 Browse through all the folders on the system.  

 Show the total disk space used by all files in a folder.  

 Select a folder for scanning.  

 Select a folder for viewing in the File Browser.  

 Select a folder for use by the Mark Duplicate Files panel.  

Scanning a folder 

To scan a folder, select the folder name with the left mouse button. Unless the Auto-scan 

when folders selected option has been set, select the File/Scan Folder command.  

When a folder is selected for scanning, it’s name in the browser will be preceded by empty 

square brackets `[ ]`. Once it has been scanned, including all subfolders under it, the total 

amount of disk space used by all files under the folder will be shown in the square brackets.  

If scanning for duplicates is also enabled, then any duplicate files found in the folders that are 

scanned will be shown in the Duplicates List Browser.  

The currently selected folder is shown in the File Browser.  

If the Auto-scan when folders selected option has been set, it is still possible to select a folder 

without scanning it by:  

 Hold down the control key while selecting the folder, or  

 Select the folder with the right mouse button (this will also bring up the context sensitive 

menu).  

Right clicking on a folder brings up the folder context menu.  

To expand a folder to show subfolders 

 Click on the + icon next to the folder name, or  

 Double click on the folder name.  

To contract a folder to hide its contents 

 Click on the - icon next to the folder name, or  

 Double click on the folder name. 
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Dragging and dropping files and folders 

Files and folders can be moved or copied by dragging them to a folder in the Folder Browser.  

The default action is to move a file or folder that is dragged.  To make a copy instead, hold 

down the CTRL key while releasing the mouse button.  You will see the cursor change to 

include a plus symbol (+) to confirm that a copy will be performed. 

Folders can be dragged within the Folder Browser, or can be dragged from the File Browser.  

Files can be dragged from the File Browser, or the Duplicate Files Browser. 

Files and folders can also be dragged to or from other applications that support drag and drop, 

such as Windows Explorer. 

 When you move or copy files or folders, you will need to rescan the folders affected to 

update the folder size information. 

 

File Browser 

 

 

The file browser shows the contents of the folder currently selected in the Folder Browser.  

For each item in the folder, the following information can be listed:  

 Name  

 Disk space used  

 File size, or total size of all contained files for folders  

 Modification time  

 The number of duplicates  

The Name column is always shown. The other columns can be shown or hidden depending on 

the options set in the column options panel. A quick way to set these options is to right click 

on any of the column headers, and select the columns from the menu that pops up.  

The Number of duplicates column only has values if the file has been scanned for duplicates. 

The value shown includes this file, so if no other copies of the file have been found, the value 

shown is 1. If the file has one other copy, the value shown is 2, and so on. 

The file list can be sorted by name, disk space, file size or modification time. By default it is 

sorted by file size. To change this, click in the title box of the column you want to sort by. If 

you click a second time in the same title box, the sort order is reversed.  

 Sorting by the number of duplicates provides a quick way of bringing all the files that have 

duplicates together.  
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Once a folder has been scanned for duplicates, the file browser also shows whether each file 

is unique, or if there is another copy of the file. This is shown by one of the following 

symbols next to the name:  

 File or folder is unique 

 There is another copy of this file or folder 

 Empty file or folder 

 

A folder is shown as empty if it contains no files. An empty folder may contain subfolders, 

but none of these subfolders can contain any files either. Empty folders can be quickly deleted 

using the File/Delete Empty Folders command.  

For two folders to be shown as duplicates of each other, they must contain exactly the same 

files (including the same filenames). If they contain any subfolders, these must be identical as 

well. If a folder is marked as being a duplicate, then the other folder(s) that it is a duplicate of 

can be seen by using the File/Next Duplicate and File/Previous Duplicate commands. These 

commands are only enabled if a duplicate folder is selected, and they cycle the selected folder 

between folders that are duplicates of each other.  

When a file is shown to be a duplicate, the other copies of that file can be found by selecting 

the file. The other copies of the file will then be shown in the Duplicate Files Browser.  

Right clicking on a folder brings up the folder context menu, and right clicking on a file 

brings up the file context menu. Multiple folders or files can be selected by holding down 

SHIFT while selecting to extend the selection, or CTRL to toggle the selection status of the 

item picked.  

 

Duplicates List Browser 

 

 

 

The Duplicates List Browser shows the duplicate files that have been found. This window is 

only enabled if the Find Duplicate Files box is checked. Each line in the list shows one set of 

files that are all identical copies of each other. The information that can be shown for each set 

of identical files is:  

 File names. If two or more files have the same name, the name is only shown once.  

 File size. All files must be the same size since they are exact copies of each other.  

 The number of duplicate files.  

 The total size of the duplicate files.  
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The Name column is always shown. The other columns can be shown or hidden depending on 

the options set in the column options panel. A quick way to set these options is to right click 

on any of the column headers, and select the columns from the menu that pops up.  

To see the full paths to each of the files in a duplicates set, select the line. The Duplicate Files 

Browser will then show the path for each file.  

Right clicking on a duplicates set brings up the file context menu. Selecting one of the 

commands in this menu will cause the command to be applied to each of the files in the 

duplicates set.  

The duplicates list can be sorted by name, size, number of duplicates or total size of 

duplicates. By default, it is sorted by size. To change this, click in the title box of the column 

you want to sort by. If you click a second time in the same title box, the sort order is reversed. 

During scanning, duplicates are added to the duplicates list as they are found. The list is kept 

sorted until more than 1,000 duplicates have been found. From then on, new duplicates are 

added to the end of the list. If you want to resort the duplicates while scanning is still in 

progress, simply click in the title box of the column you want to sort on. When scanning 

completes, the list will be resorted automatically. The reason for not keeping the duplicates 

list sorted once more than 1,000 duplicates have been added is that it would make the 

duplicates scanning process much slower if a large number of duplicates are found. 

Duplicate Files Browser 

 

 

 

The Duplicate Files Browser shows each of the files that are in the currently selected 

duplicates set in the Duplicates List Browser. The files shown in the Duplicate Files Browser 

will be duplicates of each other.  

For each file in the list, the following information can be listed:  

 Name  

 Full path to the file.  

 Modification time  

The Name column is always shown. The other columns can be shown or hidden depending on 

the options set in the column options panel. A quick way to set these options is to right click 

on any of the column headers, and select the columns from the menu that pops up.  

Selecting a file in the Duplicate Files Browser causes the Folder Browser to be expanded to 

show the folder in which the file exists. The file is also selected in the File Browser.  

Right clicking on a file brings up the file context menu.  
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 Pressing F5 in this window advances to the next duplicates set, and shift+F5 steps back to 

the previous duplicates set. This allows you to go through all the duplicate files marking the 

ones you choose, using just keyboard shortcuts. 

 

Toolbar 

 

 

The toolbar is displayed across the top of the application window, below the menu bar. The 

toolbar provides quick mouse access to commonly used commands.  

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

 

Click To Menu command 

 Scan current folder for duplicate files. File/Scan Folder 

 Stop scanning folders. File/Stop Scanning 

 Clears all folder sizes and the duplicate files list. File/Clear All Data 

 Brings up the Report panel. File/Report 

 Brings up the File Filter panel. Filter/Filter Files 

 Brings up the Folder Filter panel. Filter/Filter Folders 

 Bring up the About box. Help/About SpaceMan 99 

 Bring up the context sensitive help cursor.  

 

The position of the toolbar can be adjusted by dragging the edge to the left of the buttons. 

 

Find-Duplicates Options 

 

These options are above the Duplicates List browser.   

Find Duplicate Files 

When this box is checked, SpaceMan 99 will scan for both duplicate files/folders and folder 

size when the File/Scan Folder command is selected. Any duplicate files found will be shown 

in the Duplicates List Browser. 

If the box is not checked, then SpaceMan 99 will only scan for folder size. If you only want to 

scan folders for size, it is much quicker to turn off the Find Duplicate Files option. 

Shortcut 

Key: F2 



   SpaceMan 99 User Guide 
 

16 

 

The other options control how duplicate files are detected.  They only have any effect when 

the Find Duplicate Files option is enabled. 

Omit Small Files 

The Omit Small Files drop down list is above the duplicates list browser. In the picture above, 

it is the one showing the value All Files. It only has any effect if the Find Duplicate Files 

option is enabled.  

This option allows small files to be omitted when scanning for duplicates. The reason for 

wanting to do this is to speed up the scanning process.  

If you are looking for large files that have duplicate copies in order to find files to delete to 

free up disk space, then the speed with which these can be found can be increased by not 

checking smaller files.  

The following table lists the options available from this control. 

All Files All files will be included in the scan 

Omit < 1KB Files less than 1KB (1,024 bytes) will not be scanned 

Omit < 10KB Files less than 10KB (10,240 bytes) will not be scanned 

Omit < 100KB Files less than 100KB (102,400 bytes) will not be scanned 

Omit < 1MB Files less than 1MB (1,048,576 bytes) will not be scanned 

Omit < 10MB Files less than 10MB (10,485,760 bytes) will not be scanned 

Omit < 100MB Files less than 100MB (104,857,600 bytes) will not be scanned 

Omit < 1GB Files less than 1GB (1,073,741,824 bytes) will not be scanned 

 

Note: This control only affects scanning for duplicates. Files of all sizes are always included 

in the scan for folder sizes. 
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Match Contents 

There are three ways that the contents of the files can be compared: 

Contents A byte by byte comparison is done when testing any two files to determine if they 

are duplicates. Obviously since every byte in the two files must match, the files 

must have the same size. This option guarantees that two files marked as 

duplicates will have exactly the same contents. This option is the slowest of the 

three, although some special techniques are used to ensure it runs as quickly as 

possible.  

Checksum 

& Size 
A checksum value is calculated for each file, and this and the file size is compared 

when testing for duplicate files. This option does not guarantee that two files 

marked as duplicates have exactly the same contents, although the chances of any 

two files with different contents having the same checksum is 1 in 4,294,967,296.  

Size Only Only the size of the file is compared when testing for duplicate files. This option 

is not very useful on its own, but if used in conjunction with the match date 

option it provides a way of doing a very quick test for duplicate files that were 

made by making copies of files. 

Name Only The contents of the file are completely ignored when testing for duplicate files. 

The Match Filename option is automatically enabled so that files are considered 

to be duplicates simply if their filenames match. When this option is selected, the 

size column in the duplicates list browser just shows a dash, since the sizes of the 

files in a duplicates set may not be the same. 

 

Match Filename 

If the Match Filename box is not checked, then the file names are ignored when looking for 

duplicate files. 

If this box is checked, then the file names of any duplicate files must also match before the 

files will be recorded as duplicates. 

Match Date 

If the Match Date box is not checked, then the last-modified date of every file is ignored 

when looking for duplicate files. 

If this box is checked, then the last-modified date of any duplicate files must also match 

before the files will be recorded as duplicates. 

Note that when files are copied, the last-modified date of the file is also copied, so this option 

is useful if you want to look for files that are not only duplicates, but which were also 

probably copied from the same original file. 

 



   SpaceMan 99 User Guide 
 

18 

Menu commands 

File menu 

The File menu offers the following commands: 

Open Opens the selected file(s). 

Explore Opens the selected folder in Windows Explorer. 

Delete Deletes the selected file(s) or folder(s). 

Delete Empty Folders Deletes any empty folders under the selected folder. 

Scan Scans the currently selected folder. 

Stop Scanning Stops scanning currently in progress. 

Clear Clears folder size and duplicate file data under the currently selected 

folder. 

Clear All Data Clears all folder size and duplicate file data. 

Next Duplicate Selects the next duplicate of the currently selected file or folder. 

Previous Duplicate Selects the previous duplicate of the currently selected file or folder. 

Report Brings up the Reports panel. 

Exit Exits SpaceMan 99. 

 

Open command 

This command opens the currently selected file(s). If the file is an executable, it is run. 

Otherwise, it is opened using the application associated with the file type under Windows. 

The type of a file is determined by it's extension, which is the part of the name after the period 

character (.) in the name.  

This command is only enabled if one or more files are selected. It cannot be used on folders. 

 

Explore command 

This command opens the currently selected folder in Windows Explorer.  

This command is only enabled when a single folder is selected. It cannot be used on files. 

 

Delete command 

This command deletes the currently selected folders or files. The currently selected folders or 

files are those which are selected in the active panel of the main window. The active panel is 

the one that has the selection highlighted.  

When the duplicates list is the active panel, the selected files will be all the duplicate files at 

the selected line. If this is deleted, then all the duplicate files on the selected line will be 

deleted, leaving no copies of these files.  

When files or folders are deleted, they are moved to the recycle bin on your Windows 

desktop, unless the recycle bin option has been set to permanently delete files immediately.  
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To change the recycle bin options, right click on the recycle bin icon on the desktop, and 

choose Properties from the menu that pops up.  

To permanently delete files that have been moved to the recycle bin, right click on the recycle 

bin icon on the desktop, and choose Empty Recycle Bin from the menu that pops up.  

Shortcut 

Key: DEL 

 

Delete Empty Folders command 

This command deletes any empty folders under the currently selected folder. The currently 

selected folder is the one selected in the active panel of the main window. The active panel is 

the one that has the selection highlighted.  

This command is useful after marking and deleting duplicate files, which can lead to lots of 

empty folders.  

A folder is considered empty if it contains no files, and either no folders or only empty 

folders.  

Any folders deleted are moved to the recycle bin on your Windows desktop, unless the 

recycle bin option has been set to permanently delete files immediately.  

To change the recycle bin options, right click on the recycle bin icon on the desktop, and 

choose Properties from the menu that pops up.  

To permanently delete files or folders that have been moved to the recycle bin, right click on 

the recycle bin icon on the desktop, and choose Empty Recycle Bin from the menu that pops 

up.  

 Note that a folder must be scanned before all empty folders under it can be detected. 

Scanning for duplicates is not required, so this option can be turned off to speed up the scan. 

Shortcut 

Keys: ALT, F, E 

 

Scan Folder command 

 

This command scans the currently selected folder and all of its subfolders. This is usually the 

folder selected in the Folder Browser. However, if the File Browser is the active panel (the 

one that has the selection highlighted) and a folder is selected in the File Browser, then this is 

the folder than will be scanned.  

If you want to scan several folders, they can each be selected in turn for scanning. You do not 

need to wait for each one to complete before selecting the next. You can also select folders 

from different drives for scanning. Simply select each folder in turn in the Folder Browser and 

select the Scan Folder command. You can scan an entire drive (such as C:) by selecting the 

drive itself and then selecting the Scan Folder command. If you want to scan all the drives on 

your system, you will need to select each in turn and select the Scan Folder command. 

The Scan Folder command can only be used on physical folders that exist on drives. Virtual 

folders, such as the My Computer folder, cannot be scanned.  

If the Auto-scan when folders selected option is selected, then this command does not need to 

be used, since folders will be scanned as soon as they are selected.  
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When a folder is scanned, the sizes of all the files in the folder are added together to find the 

total size for that folder. Any subfolders in that folder are also scanned. Note: the exception to 

this is if any file or folder filters have been defined.  

If duplicates scanning is enabled, then the contents of the files and folders are also examined 

to build up lists of duplicate files and folders.  

Shortcut 

Key: F3 

Stop Scanning command 

 

This command stops any scanning currently in progress. Any information already gathered 

will be kept.  

The toolbar button animates while scanning is in progress, and is grayed when there is none.  

Shortcut 

Key: ESC 

 

Clear Folder Data command 

Clears all the size and duplicates information that has been found for the selected folder, and 

for all subfolders under it.  

This command is similar to the Clear All Data menu command, except that it only clears 

information about the selected folder. This command can be useful to exclude certain folders 

that contain duplicate files that you want to ignore, or to rescan folders that contain files 

which have been changed, added or removed by other applications.  

Shortcut 

Keys: ALT, F, C 

 

Clear All Data command 

 

Clears all the folder-size information and duplicate file data already gathered. This may be 

useful if lots of files have been changed, added or removed by other applications, and you 

want to rescan all the folders already scanned.  

Shortcut 

Keys: ALT, F, A 

 

Next Duplicate command 

This command is only enabled if the currently selected file or folder in the File Browser has 

duplicates.  

For files it simply steps to the next entry in the Duplicate Files Browser.  

For folders, the next folder in the list of duplicates of the selected folder is selected. Note that 

the only ways to view the duplicates of a folder are either to step through them with this 
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command or the previous duplicate command, or to use the duplicate folders report from the 

report panel.  

Once this command has been used to cycle through every duplicate, the first duplicate is 

selected again.  

Shortcut 

Key: F10 

 

Previous Duplicate command 

This command is only enabled if the currently selected file or folder in the File Browser has 

duplicates.  

For files it simply steps to the previous entry in the Duplicate Files Browser.  

For folders, the previous folder in the list of duplicates of the selected folder is selected. Note 

that the only ways to view the duplicates of a folder are either to step through them with this 

command or the next duplicate command, or to use the duplicate folders report from the 

report panel.  

Shortcut 

Keys: Shift+F10 

 

Report command 

 

This command brings up the Report panel, which allows you to select one of four different 

reports. These reports can then be printed or copied to another application. 

Shortcut 

Keys: ALT, F, R 

 

Exit command 

Use this command to end your SpaceMan 99 session. You can also use the Close command 

on the application Control menu.  

Shortcuts 

Mouse: Double-click the application's Control menu button. 

Keys: ALT+F4 
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Mark menu 

The Mark menu offers the following commands: 

Mark Mark the currently selected file(s). 

Unmark Unmarks the currently selected file(s). 

Mark Duplicate Files Marks duplicate files in the currently selected folder. 

Unmark All Files Unmarks all files. 

View Marked Files Brings up a panel that shows all marked files. 

Delete Marked Files Deletes all marked files. 

 

Mark command 

This command marks the currently selected files. If any folders are selected, then this 

command marks all files contained within the selected folders, including all subfolders. Any 

files already marked are not affected by this command. 

To unmark a marked file, use the Unmark command. 

The total number and size of all the marked files is shown in the status bar. The marked files 

can be viewed using the View Marked Files command. 

Shortcut 

Key: F8 

 

Unmark command 

This command unmarks the currently selected files. If any folders are selected, then this 

command unmarks all files contained within the selected folders, including all subfolders. 

Any files already unmarked are not affected by this command. 

To mark a file, use the Mark command. 

Shortcut 

Key: SHIFT+F8 

 

Mark Duplicate Files command 

This command brings up a dialog box that allows you to mark duplicate files. If any scanning 

is in progress, it is stopped when you bring up the mark duplicate files dialog. 

Shortcut 

Keys: ALT, M, M 

See: Mark Duplicate files Dialog. 
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Unmark All Files command 

This commands unmarks all files. 

Shortcut 

Keys: ALT, M, U 

 

View Marked Files command 

This command brings up the Marked Files panel, which shows a list of all marked files. 

Shortcut 

Keys: ALT, M, V 

 

Delete Marked Files command 

This command deletes all the marked files. Marked files can be viewed using the View 

Marked Files command. 

When files are deleted, they are moved to the recycle bin on your Windows desktop, unless 

the recycle bin option has been set to permanently delete files immediately.  

To change the recycle bin options, right click on the recycle bin icon on the desktop, and 

choose Properties from the menu that pops up.  

To permanently delete files that have been moved to the recycle bin, right click on the recycle 

bin icon on the desktop, and choose Empty Recycle Bin from the menu that pops up. 

Shortcut 

Keys: ALT, M, D 

 

Filter menu 

The Filter menu offers the following commands: 

Filter Files Brings up the File Filter panel 

Filter Folders Brings up the Folder Filter panel. 

Clear Filters Clears any file or folder filters that have been set. 

Exclude Folder Excludes the selected folder. 

Exclude Subfolders Excludes all subfolders of the selected folder. 

 

Filter Files command 

 

This command brings up the File Filter panel that allows you to specify file patterns that 

should be excluded when scanning the disk.  

The button on the toolbar indicates if there are any filtered files, it has no color when there are 

no filtered files.  
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Shortcut 

Keys: ALT, I, F 

 

Filter Folders command 

 

This command brings up the Folder Filter panel that allows you to specify folders that should 

be excluded when scanning the disk.  

The button on the toolbar indicates if there are any filtered folders, it has no color when there 

are no filtered folders.  

Shortcut 

Keys: ALT, I, O 

 

Clear Filters command 

This command clears any file filters or folder filters that have been set.  

Note that whenever any changes are made to the list of excluded folders, any folder-size 

information and duplicate file data already gathered is cleared.  

Shortcut 

Keys: ALT, I, C 

 

Exclude Folder command 

This command adds the selected folder to the list of excluded folders. This will cause the 

folder to disappear from the folders shown. 

Note that whenever any changes are made to the list of excluded folders, any folder-size 

information and duplicate file data already gathered is cleared.  

Shortcut 

Key: F7 

 

Exclude Subfolders command 

This command adds all the subfolders of the selected folder to the list of excluded folders. 

This will cause all the subfolders to disappear from the folders shown. 

Note that whenever any changes are made to the list of excluded folders, any folder-size 

information and duplicate file data already gathered is cleared.  

Shortcut 

Keys: ALT+F7 
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View menu 

The View menu offers the following commands: 

Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

Show Size As Popup menu that allows the units used to show sizes to be customized. 

Options Brings up the Options panel 

 

View Toolbar command 

Use this command to display and hide the Toolbar, which includes buttons for some of the 

most common commands in SpaceMan 99. A check mark appears next to the menu item 

when the Toolbar is displayed. 

 

View Status Bar command 

Use this command to display and hide the Status Bar, which describes the action to be 

executed by the selected menu item or depressed toolbar button. A check mark appears next 

to the menu item when the Status Bar is displayed. 

 

View Options command 

This command brings up the dialog box that allows you to change configuration preferences 

for SpaceMan 99. 

Shortcut 

Keys: ALT, V, O 

 

Help menu 

The Help menu offers the following commands, which provide you assistance with this 

application:  

Help Topics Offers you an index to topics on which you can get help. 

About SpaceMan 99 Displays the version number of this application, and whether it is 

registered or not. 

 

Help command 

Opens the help window, showing the contents. 

To get context sensitive help on the currently selected object, press F1. 

Shortcut 

Keys: ALT, H, H 
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About command 

 

Use this command to display the copyright notice and version number of your copy of 

SpaceMan 99. If you have not yet registered your copy of SpaceMan 99, this will also display 

how many days you have left before your evaluation period expires. 

Shortcut 

Keys: ALT, H, A 
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Panels 

Mark Duplicates panel 

 To bring up the mark duplicate files panel, select a folder in the folder browser, and then 

use the Mark/Mark Duplicate Files command.  

When the mark duplicate files panel appears, the selected folder is shown at the top of the 

panel. To change the selected folder, close down the panel, select a new folder, and then use 

the mark duplicate files command again. You can not simply type a new selected folder path 

into the panel itself.  

The mark duplicate files panel provides a way to mark duplicate files so that all copies of a 

file can not be marked. This makes it easy to delete redundant copies of a file without 

accidentally deleting all copies of a file. There are a number of options to allow you to set 

which of the duplicate files is not marked.  

 Mark duplicate files inside selected folder except newest 

This option marks all duplicate files inside the selected folder (or any subfolder), except 

the file in each set of duplicate files that has the newest modification time. If more than 

one of the duplicate files have the newest modification time, then it will be arbitrary which 

of them is not marked.  

 Mark duplicate files inside selected folder except oldest 

This option marks all duplicate files inside the selected folder (or any subfolder), except 

the file in each set of duplicate files that has the oldest modification time.  

 Mark duplicate files inside selected folder, which have a copy outside 

This option marks all duplicate files inside the selected folder (or any subfolder), provided 

they have at least one copy outside the selected folder. This is useful if you want to delete 

a folder and be sure that you still have copies of all the files it contains elsewhere on the 

system.  

 Mark duplicate files outside selected folder, which have a copy inside 

This option marks all duplicate files outside the selected folder, provided they have at least 

one copy inside the selected folder (or any subfolder). This option allows you to clean up 

your system so that any copies of a file are in a known folder. If you have some files that 

you may have several copies of in different places, you can choose one folder where you 

want these files to be stored. After putting one copy of these files in the chosen folder, you 

can use the mark duplicate files command to mark any other copies of these files anywhere 

else on your system (or at least, in any other folders you have scanned).  

 

When the mark duplicate files command is selected, the first thing that happens is that all files 

in the selected folder are checked to see if any are duplicates. If the selected folder has not 

been scanned for duplicates and nor have any subfolders under it, or if no duplicate files are 

found, then a message box is shown. Otherwise the mark duplicate files panel appears. If the 

list of files shown in the mark duplicate files panel is empty, then all the duplicate files found 

in the selected folder only have copies that are also inside the selected folder.  

The list inside the panel shows the files that will be marked if the Mark button is pressed. 

The list changes as you select between the different options for selecting which duplicates are 

marked.  
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Note that when the mark duplicate files panel is brought up, it does not perform any new 

scanning of files. You should make sure that all folders that you want to check for duplicates 

have already been scanned before bringing up the mark duplicate files panel.  

 

Marked Files panel 

 To bring up the marked files panel, use the Mark/View Marked Files command.  

This panel shows all the files that are currently marked. Files in the list can be unmarked 

(which removes them from the list) or deleted by using commands on the marked files menu.  

Marked files can be sorted by name, size or path. Click on the appropriate column header to 

sort on that value. Clicking a second time on the same column header reverses the sort order.  

To change the sizes of the columns, drag the right edge of the column headers. 

 

Report panel 

 To bring up the report panel, use the File/Report command.  

Before you use the report panel, you need to have scanned one or more folders for disk space, 

or for duplicate files. To select the report you want to see, click on one of the tabs at the top of 

the report panel. The report panel can show each of the following reports.  

 Total Folder Sizes report 

This report shows the total size of all files in each scanned folder, including subfolders. It 

also shows the total size of all the subfolders under each folder. The folders are sorted first 

by depth (i.e. how deep in the folder hierarchy they are), and then by size, with the largest 

shown first. The size shown is either the total disk space used by the files, or the sum of 

the individual file sizes, depending on the option set on the Report Options panel.  

 Folder Sizes report 

This report shows the total size of all files in each scanned folder, excluding subfolders. 

The folders are sorted by size, with the largest shown first. The size shown is either the 

total disk space used by the files, or the sum of the individual file sizes, depending on the 

option set on the Report Options panel.  

 Duplicate Files report 

This report shows all the duplicate files. The first column shows the file sizes. If the option 

to show the last-modified time is selected in the Report Options panel, then the second 

column shows the last-modified time for each file. The last column shows the duplicate 

files. The files are grouped so that files that are duplicates of each other are shown 

together. Each set of duplicate files is separated by a blank line. Since the size of all files 

that are duplicates of each other must obviously be the same, the size is only shown once 

per duplicates set.  

 Duplicate Folders report 

This report shows all the duplicate folders. The first column shows the total size. This is 

shown either as the total disk space used by the files, or the sum of the individual file sizes, 

depending on the option set on the Report Options panel. Note that since duplicate folders 

might be on different disks, it is possible to have a different size shown even though the 

folders contain identical files, if the disks have different cluster sizes. The second column 

shows the path to the folder.  The folders are grouped so that folders that are duplicates of 

each other are shown together. Each set of duplicate folders is separated by a blank line.  
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The following buttons are at the bottom of the report panel: 

Options 
This brings up the Options panel with the Report tab selected. This allows you to 

make changes to the report options while the Report Panel is displayed.  

Copy To 

Clipboard 

Copies the current selection from the current report to the clipboard. A selection 

can be made in the current report by dragging over the part you want to select. If 

there is no selection, then the whole report is copied to the clipboard. This can 

then be copied into another application. When a report is copied to the clipboard, 

the columns in the reports are separated by the TAB character. This means that 

the data can be copied into a spreadsheet such as Excel, and the data will be 

copied properly into rows and columns. It is then easy to make charts of the data 

if you want to see the results graphically.  

Print 
Prints the current selection from the current report, or the entire report if there is 

no selection.  

OK Closes the report panel.  

 

 

File Filter panel 

 To bring up the File Filter panel, use the Filter/Filter Files command.  

The file filter panel allows files to be excluded when the disk is being scanned. This can be 

used either to simply speed up the scanning operation by excluding files that you are not 

interested in, or to gather information about specific files, such as how much disk space is 

being used by a particular type of file.  

The files that are filtered out can be specified in one of two ways. You can either list the files 

that should be excluded, or list just those that should be included. To select which of these to 

use, click on the pop-up list box and select the required option:  

To specify the files to exclude or include, the standard wild-card symbols * and ? are used. * 

matches any characters, and ? matches any one character. By far the most common way to 

specify files to exclude or include is by the file extension, since this defines the type of the 

file. For example, to specify all Microsoft Word files, you would use *.doc.  

The wild-card symbols can be used in any combination, so fairly powerful patterns can be 

defined. For example, a*.??? would match any filename that started with a, and had an 

extension that had exactly three characters.  

To add a file to the list, press the New button.  

To change a file, double click it in the file list box and make the change required.  

To remove a file, select it in the file list box and press the Remove button.  

To remove all file patterns, press the Remove All button.  

Note that excluded files are no longer shown in the file browser. They will reappear in the file 

browser if the filtered files list is cleared.  
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Predefined file groups 

Various predefined file groups can be quickly added by selecting them from the predefined 

file groups pop-up list. This has file patterns for various common groups of files, such as 

common image file types, temporary files, and so on.  

This list can be customized by editing the file filegroups.txt in SpaceMan 99’s installation 

folder. This file starts with the name of the first group on one line, followed by lines 

containing the file patterns making up that group, and ending in a blank line. The next group 

then follows, and so on until the end of the file. 

 

 

Folder Filter panel 

 To bring up the Folder Filter panel, use the Filter/Filter Folders command.  

This panel allows folders to be excluded. This can be used to speed up scanning by excluding 

folders that you are not interested in.  

To add a folder to the list, press the New button.  

You can then either type in the path to the folder you want to exclude, or press the ... button to 

bring up a folder browser panel. If you type in the path to the folder, the full path including 

the drive letter must be entered. It is also possible to use the standard wild-card symbols * and 

? in the name to match several folders. * matches any characters, although it will not match 

through a folder separator \. ? matches any one character, except a folder separator \.  

To change a folder, double click it in the folder list box and make the change required.  

To remove a folder, select it in the folder list box and press the Remove button.  

To remove all folder patterns, press the Remove All button.  

Note that excluded folder are no longer shown in the folder browser or the file browser. They 

will reappear if the filtered folders list is cleared.  

Also note that whenever any changes are made to the list of excluded folders, any folder-size 

information and duplicate file data already gathered is cleared. If you have not made any 

changes to the excluded folders after bringing up this panel, you should press Cancel instead 

of OK to prevent any existing data being cleared.  

Predefined folder groups 

The system folder is always available in the predefined folder groups pop-up list.  

If there are any groups of folders that you commonly want to exclude, these can be entered 

into a file called foldergroups.txt in SpaceMan 99’s installation folder. This file starts with the 

name of the first group on one line, followed by lines containing the folders making up that 

group, and ending in a blank line. The next group then follows, and so on until the end of the 

file. This file is read when the Folder Filter panel is brought up, and the groups defined in this 

file appear in the predefined folder groups pop-up list. Selecting one of these and pressing the 

Add button will add all the folders in that group to the list of excluded folders. 
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General Options panel 

 

 

 

 To bring up the General options panel, use the View/Options command, and select the 

General tab.  

The General tab of the Options panel allows you to set the following options: 

File 

Protection 

Sets whether the Windows operating system files are protected from deletion. If 

this option is enabled, then you will be unable to delete any files in the Windows 

folder from within SpaceMan 99.  

The protected folder is shown. This is fixed by the operating system and can not 

be changed.  

Sounds Sets whether SpaceMan 99 plays a sound whenever a scan is finished. 

Recent 

Folders 

The Address Box stores the 20 most recently accessed folders. This list is saved 

between SpaceMan 99 sessions unless the Clear recent folders list when app 

exits checkbox is set. 

Auto-scan 
If the Auto-scan when folders selected option is set, then folders are 

automatically scanned when they are selected in the Folder Browser. 
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Column Options panel 

 

 

 

 To bring up the Column options panel, use the View/Options command, and select the 

Columns tab.  

The Columns tab of the Options panel allows the columns shown in each of the files browser, 

duplicates list and duplicate files views to be configured.  

Using the context menu 

Note that it is also possible to configure the columns shown without using the Column 

Options panel. Right clicking in the column title boxes brings up a context menu that lists the 

columns available. The columns shown have a check mark against them. Selecting one of the 

columns from the menu toggles the state of the check mark and shows or hides the column. 
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Report Options panel 

 

 

 

 To bring up the Report options panel, use the View/Options command, and select the 

Reports tab.  

The Reports tab of the Options panel allows the reports generated in the Report panel to be 

customized.  

The Show Size As option selects whether the file or folder sizes shown in the reports are the 

actual sizes of the files or folders, or whether they are the amount of disk space used.  

The Sort Order option selects whether the items in the reports are sorted by size (largest first) 

or alphabetically by filename.  

If the Show Modified Time in Duplicates Report box is checked, then an extra column will be 

included in the duplicates report that shows the modified time for each file. 

 


